
e2 studio 4.2.0.12 
e2 studio 4.2.0 release documentation 

This document outlines the device support, new features added in 4.2.0, fixed 
issues and open issues in e2 studio 4.2.0. 

1. Project Generator Support

CPU 

Family Group Devices 

RH850 

C1H R7F701260, R7F701270,(Debug Support Only) 

C1M R7F701263, R7F701271,(Debug Support Only) 

E1L R7F701201, R7F701205,(Debug Support Only) 

E1M-S R7F701202, R7F701204,(Debug Support Only) 

E1x-FCC1 R7F701Z05, R7F701Z06, R7F701Z07,(Debug Support Only) 

F1H 

R7F701501, R7F701502, R7F701503, R7F701506, R7F701507, 

R7F701508, R7F701511, R7F701512, R7F701513,(Debug Support 

Only) 

F1H-GW 

R7F701521, R7F701522, R7F701524, R7F701525,(Debug Support 

Only) 

F1L 

R7F701002xAFP, R7F701003xAFP, R7F701006xAFP, R7F701007xAFP, 

R7F701008xAFP, R7F701009xAFP, R7F701010xAFP, R7F701011xAFP, 

R7F701012xAFP, R7F701013xAFP, R7F701014xAFP, R7F701015xAFP, 

R7F701016xAFP, R7F701017xAFP, R7F701018xAFP, R7F701019xAFP, 

R7F701020xAFP, R7F701021xAFP, R7F701022xAFP, R7F701023xAFP, 

R7F701024xAFP, R7F701025xAFP, R7F701026xAFP, R7F701027xAFP, 

R7F701028xAFP, R7F701029xAFP, R7F701030xAFP, R7F701032xAFP, 

R7F701033xAFP, R7F701034xAFP, R7F701040, R7F701041, 

R7F701042, R7F701043, R7F701044, R7F701045, R7F701046, 

R7F701047, R7F701048, R7F701049, R7F701050, R7F701051, 

R7F701052, R7F701053, R7F701054, R7F701055, R7F701056, 

R7F701057,(Debug Support Only) 

F1M 

R7F701544, R7F701545, R7F701548, R7F701549, R7F701552, 

R7F701553, R7F701564, R7F701565, R7F701568, R7F701569, 

R7F701572, R7F701573,(Debug Support Only) 

P1M 

R7F701304, R7F701305, R7F701310, R7F701311, R7F701312, 

R7F701313, R7F701314, R7F701315, R7F701318, R7F701319, 

R7F701320, R7F701321, R7F701322, R7F701323,(Debug Support 

Only) 

 - 

R7F701060xAFP, R7F701062xAFP, R7F701064xAFP, R7F701065xAFP, 

R7F701067xAFP, R7F701069xAFP, R7F701071xAFP,(Debug Support 

Only) 

RL78 

D1A 

R5F10CGB, R5F10CGC, R5F10CGD, R5F10CLD, R5F10CMD, 

R5F10CME, R5F10DGC, R5F10DGD, R5F10DGE, R5F10DLD, 

R5F10DLE, R5F10DMD, R5F10DME, R5F10DMF, R5F10DMG, 

R5F10DMJ, R5F10DPE, R5F10DPF, R5F10DPG, R5F10DPJ, R5F10DPK, 

R5F10DPL, R5F10DSJ, R5F10DSK, R5F10DSL, R5F10TPJ 
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F12 

R5F10968, R5F1096A, R5F1096B, R5F1096C, R5F1096D, R5F1096E, 

R5F109AA, R5F109AB, R5F109AC, R5F109AD, R5F109AE, R5F109BA, 

R5F109BB, R5F109BC, R5F109BD, R5F109BE, R5F109GA, R5F109GB, 

R5F109GC, R5F109GD, R5F109GE, R5F109LA, R5F109LB, R5F109LC, 

R5F109LD, R5F109LE 

F13 

R5F10A6A, R5F10A6C, R5F10A6D, R5F10A6E, R5F10AAA, R5F10AAC, 

R5F10AAD, R5F10AAE, R5F10ABA, R5F10ABC, R5F10ABD, R5F10ABE, 

R5F10AGA, R5F10AGC, R5F10AGD, R5F10AGE, R5F10AGF, 

R5F10AGG, R5F10ALC, R5F10ALD, R5F10ALE, R5F10ALF, R5F10ALG, 

R5F10AME, R5F10AMF, R5F10AMG, R5F10BAC, R5F10BAD, 

R5F10BAE, R5F10BAF, R5F10BAG, R5F10BBC, R5F10BBD, R5F10BBE, 

R5F10BBF, R5F10BBG, R5F10BGC, R5F10BGD, R5F10BGE, R5F10BGF, 

R5F10BGG, R5F10BLC, R5F10BLD, R5F10BLE, R5F10BLF, R5F10BLG, 

R5F10BME, R5F10BMF, R5F10BMG 

F14 

R5F10PAD, R5F10PAE, R5F10PBD, R5F10PBE, R5F10PGD, R5F10PGE, 

R5F10PGF, R5F10PGG, R5F10PGH, R5F10PGJ, R5F10PLE, R5F10PLF, 

R5F10PLG, R5F10PLH, R5F10PLJ, R5F10PME, R5F10PMF, R5F10PMG, 

R5F10PMH, R5F10PMJ, R5F10PPE, R5F10PPF, R5F10PPG, R5F10PPH, 

R5F10PPJ 

F15 

R5F113GK, R5F113GL, R5F113LK, R5F113LL, R5F113MK, R5F113ML, 

R5F113PG, R5F113PH, R5F113PJ, R5F113PK, R5F113PL, R5F113TG, 

R5F113TH, R5F113TJ, R5F113TK, R5F113TL 

F1A R5F114GC, R5F114GD, R5F114GE, R5F114GF, R5F114GG 

G10 R5F10Y14, R5F10Y16, R5F10Y17, R5F10Y44, R5F10Y46, R5F10Y47 

G12 

R5F10266, R5F10267, R5F10268, R5F10269, R5F1026A, R5F10277, 

R5F10278, R5F10279, R5F1027A, R5F102A7, R5F102A8, R5F102A9, 

R5F102AA, R5F10366, R5F10367, R5F10368, R5F10369, R5F1036A, 

R5F10377, R5F10378, R5F10379, R5F1037A, R5F103A7, R5F103A8, 

R5F103A9, R5F103AA 
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G13 

R5F1006A, R5F1006C, R5F1006D, R5F1006E, R5F1007A, R5F1007C, 

R5F1007D, R5F1007E, R5F1008A, R5F1008C, R5F1008D, R5F1008E, 

R5F100AA, R5F100AC, R5F100AD, R5F100AE, R5F100AF, R5F100AG, 

R5F100BA, R5F100BC, R5F100BD, R5F100BE, R5F100BF, R5F100BG, 

R5F100CA, R5F100CC, R5F100CD, R5F100CE, R5F100CF, R5F100CG, 

R5F100EA, R5F100EC, R5F100ED, R5F100EE, R5F100EF, R5F100EG, 

R5F100EH, R5F100FA, R5F100FC, R5F100FD, R5F100FE, R5F100FF, 

R5F100FG, R5F100FH, R5F100FJ, R5F100FK, R5F100FL, R5F100GA, 

R5F100GC, R5F100GD, R5F100GE, R5F100GF, R5F100GG, R5F100GH, 

R5F100GJ, R5F100GK, R5F100GL, R5F100JC, R5F100JD, R5F100JE, 

R5F100JF, R5F100JG, R5F100JH, R5F100JJ, R5F100JK, R5F100JL, 

R5F100LC, R5F100LD, R5F100LE, R5F100LF, R5F100LG, R5F100LH, 

R5F100LJ, R5F100LK, R5F100LL, R5F100MF, R5F100MG, R5F100MH, 

R5F100MJ, R5F100MK, R5F100ML, R5F100PF, R5F100PG, R5F100PH, 

R5F100PJ, R5F100PK, R5F100PL, R5F100SH, R5F100SJ, R5F100SK, 

R5F100SL, R5F1016A, R5F1016C, R5F1016D, R5F1016E, R5F1017A, 

R5F1017C, R5F1017D, R5F1017E, R5F1018A, R5F1018C, R5F1018D, 

R5F1018E, R5F101AA, R5F101AC, R5F101AD, R5F101AE, R5F101AF, 

R5F101AG, R5F101BA, R5F101BC, R5F101BD, R5F101BE, R5F101BF, 

R5F101BG, R5F101CA, R5F101CC, R5F101CD, R5F101CE, R5F101CF, 

R5F101CG, R5F101EA, R5F101EC, R5F101ED, R5F101EE, R5F101EF, 

R5F101EG, R5F101EH, R5F101FA, R5F101FC, R5F101FD, R5F101FE, 

R5F101FF, R5F101FG, R5F101FH, R5F101FJ, R5F101FK, R5F101FL, 

R5F101GA, R5F101GC, R5F101GD, R5F101GE, R5F101GF, R5F101GG, 

R5F101GH, R5F101GJ, R5F101GK, R5F101GL, R5F101JC, R5F101JD, 

R5F101JE, R5F101JF, R5F101JG, R5F101JH, R5F101JJ, R5F101JK, 

R5F101JL, R5F101LC, R5F101LD, R5F101LE, R5F101LF, R5F101LG, 

R5F101LH, R5F101LJ, R5F101LK, R5F101LL, R5F101MF, R5F101MG, 

R5F101MH, R5F101MJ, R5F101MK, R5F101ML, R5F101PF, 

R5F101PG, R5F101PH, R5F101PJ, R5F101PK, R5F101PL, R5F101SH, 

R5F101SJ, R5F101SK, R5F101SL 

G14 

R5F104AA, R5F104AC, R5F104AD, R5F104AE, R5F104AF, R5F104AG, 

R5F104BA, R5F104BC, R5F104BD, R5F104BE, R5F104BF, R5F104BG, 

R5F104CA, R5F104CC, R5F104CD, R5F104CE, R5F104CF, R5F104CG, 

R5F104EA, R5F104EC, R5F104ED, R5F104EE, R5F104EF, R5F104EG, 

R5F104EH, R5F104FA, R5F104FC, R5F104FD, R5F104FE, R5F104FF, 

R5F104FG, R5F104FH, R5F104FJ, R5F104GA, R5F104GC, R5F104GD, 

R5F104GE, R5F104GF, R5F104GG, R5F104GH, R5F104GJ, R5F104GK, 

R5F104GL, R5F104JC, R5F104JD, R5F104JE, R5F104JF, R5F104JG, 

R5F104JH, R5F104JJ, R5F104LC, R5F104LD, R5F104LE, R5F104LF, 

R5F104LG, R5F104LH, R5F104LJ, R5F104LK, R5F104LL, R5F104MF, 

R5F104MG, R5F104MH, R5F104MJ, R5F104MK, R5F104ML, 

R5F104PF, R5F104PG, R5F104PH, R5F104PJ, R5F104PK, R5F104PL 

G1A 

R5F10E8A, R5F10E8C, R5F10E8D, R5F10E8E, R5F10EBA, R5F10EBC, 

R5F10EBD, R5F10EBE, R5F10EGA, R5F10EGC, R5F10EGD, R5F10EGE, 

R5F10ELC, R5F10ELD, R5F10ELE 

G1C R5F10JBC, R5F10JGC, R5F10KBC, R5F10KGC 

G1D R5F11AGG, R5F11AGH, R5F11AGJ 

G1E R5F10FLC, R5F10FLD, R5F10FLE, R5F10FMC, R5F10FMD, R5F10FME 
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G1F 

R5F11B7C, R5F11B7E, R5F11BBC, R5F11BBE, R5F11BCC, R5F11BCE, 

R5F11BGC, R5F11BGE, R5F11BLC, R5F11BLE 

G1G R5F11EA8, R5F11EAA, R5F11EB8, R5F11EBA, R5F11EF8, R5F11EFA 

I1A R5F1076C, R5F107AC, R5F107AE, R5F107DE 

I1B R5F10MME, R5F10MMG, R5F10MPE, R5F10MPG 

I1D 

R5F11768, R5F1176A, R5F11778, R5F1177A, R5F117A8, R5F117AA, 

R5F117AC, R5F117BA, R5F117BC, R5F117GA, R5F117GC 

I1E R5F11CBC, R5F11CCC 

L12 

R5F10RB8, R5F10RBA, R5F10RBC, R5F10RF8, R5F10RFA, R5F10RFC, 

R5F10RG8, R5F10RGA, R5F10RGC, R5F10RJ8, R5F10RJA, R5F10RJC, 

R5F10RLA, R5F10RLC 

L13 

R5F10WLA, R5F10WLC, R5F10WLD, R5F10WLE, R5F10WLF, 

R5F10WLG, R5F10WMA, R5F10WMC, R5F10WMD, R5F10WME, 

R5F10WMF, R5F10WMG 

L1C 

R5F110ME, R5F110MF, R5F110MG, R5F110MH, R5F110MJ, 

R5F110NE, R5F110NF, R5F110NG, R5F110NH, R5F110NJ, R5F110PE, 

R5F110PF, R5F110PG, R5F110PH, R5F110PJ, R5F111ME, R5F111MF, 

R5F111MG, R5F111MH, R5F111MJ, R5F111NE, R5F111NF, 

R5F111NG, R5F111NH, R5F111NJ, R5F111PE, R5F111PF, R5F111PG, 

R5F111PH, R5F111PJ 

RX 

110 R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J 

111 

R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, R5F51117, 

R5F51118, R5F5111J 

113 R5F51135, R5F51136, R5F51137, R5F51138 

130 R5F51303, R5F51305 

210 

R5F52103, R5F52104, R5F52105, R5F52106, R5F52107, R5F52108, 

R5F5210A, R5F5210B 

21A R5F521A6, R5F521A7, R5F521A8 

220 R5F52201, R5F52203, R5F52205, R5F52206 

230 R5F52305, R5F52306 

231 R5F52315, R5F52316, R5F52317, R5F52318 

23T R5F523T3, R5F523T5 

24T R5F524T8, R5F524TA 

610 R5F56104, R5F56106, R5F56107, R5F56108 

621 R5F56216, R5F56217, R5F56218 

62G R5F562G7, R5F562GA 

62N R5F562N7, R5F562N8 

62T R5F562T6, R5F562T7, R5F562TA 

630 R5F56307, R5F56308, R5F5630A, R5F5630B, R5F5630D, R5F5630E 
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631 

R5F56316, R5F56317, R5F56318, R5F5631A, R5F5631B, R5F5631D, 

R5F5631E, R5F5631F, R5F5631G, R5F5631J, R5F5631K, R5F5631M, 

R5F5631N, R5F5631P, R5F5631W, R5F5631Y, R5S56310 

R5F5631MF, R5F5631PF,(Debug Support Only) 

634 

R5F5634B, R5F5634D, R5F5634E 

R5F5634B_5V, R5F5634D_5V, R5F5634E_5V,(Debug Support Only) 

63N 

R5F563NA, R5F563NB, R5F563ND, R5F563NE, R5F563NF, R5F563NK, 

R5F563NW, R5F563NY 

63T 

R5F563T4, R5F563T5, R5F563T6, R5F563TB, R5F563TC, R5F563TE 

R5F563TB_5V, R5F563TC_5V, R5F563TE_5V,(Debug Support Only) 

64M R5F564MF, R5F564MG, R5F564MJ, R5F564ML 

71M R5F571MF, R5F571MG, R5F571MJ, R5F571ML 

RZ 

A1 

R7S72100, R7S721001, R7S72101, R7S72102 

R7S721001_DualSPI, R7S721020, R7S721020_DualSPI, R7S721021, 

R7S721021_DualSPI,(Debug Support Only) 

T1 

R7S910001, R7S910002, R7S910006, R7S910007, R7S910011, 

R7S910013, R7S910015, R7S910015_M3, R7S910016, 

R7S910016_M3, R7S910017, R7S910017_M3, R7S910018, 

R7S910018_M3, R7S910025, R7S910026, R7S910027, R7S910028, 

R7S910101, R7S910102, R7S910106, R7S910107, R7S910111, 

R7S910113, R7S910115, R7S910115_M3, R7S910116, 

R7S910116_M3, R7S910117, R7S910117_M3, R7S910118, 

R7S910118_M3, R7S910125, R7S910126, R7S910127, R7S910128 

SH 

SH2 

SH7047F, SH70834A, SH70844A, SH70854A, SH70865A, SH71242, 

SH71252, SH7144F, SH7145F, SH71464A, SH71491R, SH7615, 

SH7616, SH7618, SH7619 

SH2A-FPU SH72394B 

SH2a 

SH7201, SH7203, SH72165AD, SH72546RFCC, SH72611, SH72620, 

SH72630, SH72640, SH72690, SH7670 

SH2a (No FPU) SH7206, SH7211, SH7243, SH7285, SH7286 

Synergy S7G2 

R7FS7G27H2A01CBD, R7FS7G27G2A01CBD, R7FS7G27H2A01CBG, 

R7FS7G27G2A01CBG, R7FS7G27H2A01CFC, R7FS7G27H3A01CFC, 

R7FS7G27G2A01CFC,R7FS7G27G3A01CFC, R7FS7G27H2A01CLK, 

R7FS7G27G2A01CLK, R7FS7G27H3A01CFB, R7FS7G27G3A01CFB 

S3A7 

R7FS3A77C2A01CLK, R7FS3A77C3A01CFB, R7FS3A77C2A01CBJ, 

R7FS3A77C3A01CFP, R7FS3A77C2A01CLJ, R7FS3A77C3A01CFM, 

R7FS3A77C2A01CNB, R7FS3A77C3A01CNB 

S124 

R7FS124773A01CFM, R7FS124772A01CNB, R7FS124773A01CNB, 

R7FS124763A01CFM, R7FS124762A01CNB,R7FS124763A01CNB, 
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R7FS124773A01CFL, R7FS124772A01CNE, ,R7FS124773A01CNE, 

R7FS124763A01CFL, R7FS124762A01CNE, R7FS124763A01CNE, 

R7FS124772A01CNF, R7FS124773A01CNF, R7FS124762A01CNF, 

R7FS124763A01CNF, R7FS124772A01CLM, R7FS124762A01CLM 
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2. Code Generator Support

CPU 

Family Group Devices 

RL78 

F12 

R5F10968, R5F1096A, R5F1096B, R5F1096C, R5F1096D, R5F1096E, 

R5F109AA, R5F109AB, R5F109AC, R5F109AD, R5F109AE, R5F109BA, 

R5F109BB, R5F109BC, R5F109BD, R5F109BE, R5F109GA, R5F109GB, 

R5F109GC, R5F109GD, R5F109GE, R5F109LA, R5F109LB, R5F109LC, 

R5F109LD, R5F109LE 

F13 

R5F10A6A, R5F10A6C, R5F10A6D, R5F10A6E, R5F10AAA, R5F10AAC, 

R5F10AAD, R5F10AAE, R5F10ABA, R5F10ABC, R5F10ABD, R5F10ABE, 

R5F10AGA, R5F10AGC, R5F10AGD, R5F10AGE, R5F10AGF, R5F10AGG, 

R5F10ALC, R5F10ALD, R5F10ALE, R5F10ALF, R5F10ALG, R5F10AME, 

R5F10AMF, R5F10AMG, R5F10BAC, R5F10BAD, R5F10BAE, R5F10BAF, 

R5F10BAG, R5F10BBC, R5F10BBD, R5F10BBE, R5F10BBF, R5F10BBG, 

R5F10BGC, R5F10BGD, R5F10BGE, R5F10BGF, R5F10BGG, R5F10BLC, 

R5F10BLD, R5F10BLE, R5F10BLF, R5F10BLG, R5F10BME, R5F10BMF, 

R5F10BMG 

F14 

R5F10PAD, R5F10PAE, R5F10PBD, R5F10PBE, R5F10PGD, R5F10PGE, 

R5F10PGF, R5F10PGG, R5F10PGH, R5F10PGJ, R5F10PLE, R5F10PLF, 

R5F10PLG, R5F10PLH, R5F10PLJ, R5F10PME, R5F10PMF, R5F10PMG, 

R5F10PMH, R5F10PMJ, R5F10PPE, R5F10PPF, R5F10PPG, R5F10PPH, 

R5F10PPJ 

F15 

R5F113GK, R5F113GL, R5F113LK, R5F113LL, R5F113MK, R5F113ML, 

R5F113PG, R5F113PH, R5F113PJ, R5F113PK, R5F113PL, R5F113TG, 

R5F113TH, R5F113TJ, R5F113TK, R5F113TL 

G10 R5F10Y14, R5F10Y16, R5F10Y17, R5F10Y44, R5F10Y46, R5F10Y47 

G12 

R5F10266, R5F10267, R5F10268, R5F10269, R5F1026A, R5F10277, 

R5F10278, R5F10279, R5F1027A, R5F102A7, R5F102A8, R5F102A9, 

R5F102AA, R5F10366, R5F10367, R5F10368, R5F10369, R5F1036A, 

R5F10377, R5F10378, R5F10379, R5F1037A, R5F103A7, R5F103A8, 

R5F103A9, R5F103AA 
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G13 

R5F1006A, R5F1006C, R5F1006D, R5F1006E, R5F1007A, R5F1007C, 

R5F1007D, R5F1007E, R5F1008A, R5F1008C, R5F1008D, R5F1008E, 

R5F100AA, R5F100AC, R5F100AD, R5F100AE, R5F100AF, R5F100AG, 

R5F100BA, R5F100BC, R5F100BD, R5F100BE, R5F100BF, R5F100BG, 

R5F100CA, R5F100CC, R5F100CD, R5F100CE, R5F100CF, R5F100CG, 

R5F100EA, R5F100EC, R5F100ED, R5F100EE, R5F100EF, R5F100EG, 

R5F100EH, R5F100FA, R5F100FC, R5F100FD, R5F100FE, R5F100FF, 

R5F100FG, R5F100FH, R5F100FJ, R5F100FK, R5F100FL, R5F100GA, 

R5F100GC, R5F100GD, R5F100GE, R5F100GF, R5F100GG, R5F100GH, 

R5F100GJ, R5F100GK, R5F100GL, R5F100JC, R5F100JD, R5F100JE, 

R5F100JF, R5F100JG, R5F100JH, R5F100JJ, R5F100JK, R5F100JL, 

R5F100LC, R5F100LD, R5F100LE, R5F100LF, R5F100LG, R5F100LH, 

R5F100LJ, R5F100LK, R5F100LL, R5F100MF, R5F100MG, R5F100MH, 

R5F100MJ, R5F100MK, R5F100ML, R5F100PF, R5F100PG, R5F100PH, 

R5F100PJ, R5F100PK, R5F100PL, R5F100SH, R5F100SJ, R5F100SK, 

R5F100SL, R5F1016A, R5F1016C, R5F1016D, R5F1016E, R5F1017A, 

R5F1017C, R5F1017D, R5F1017E, R5F1018A, R5F1018C, R5F1018D, 

R5F1018E, R5F101AA, R5F101AC, R5F101AD, R5F101AE, R5F101AF, 

R5F101AG, R5F101BA, R5F101BC, R5F101BD, R5F101BE, R5F101BF, 

R5F101BG, R5F101CA, R5F101CC, R5F101CD, R5F101CE, R5F101CF, 

R5F101CG, R5F101EA, R5F101EC, R5F101ED, R5F101EE, R5F101EF, 

R5F101EG, R5F101EH, R5F101FA, R5F101FC, R5F101FD, R5F101FE, 

R5F101FF, R5F101FG, R5F101FH, R5F101FJ, R5F101FK, R5F101FL, 

R5F101GA, R5F101GC, R5F101GD, R5F101GE, R5F101GF, R5F101GG, 

R5F101GH, R5F101GJ, R5F101GK, R5F101GL, R5F101JC, R5F101JD, 

R5F101JE, R5F101JF, R5F101JG, R5F101JH, R5F101JJ, R5F101JK, 

R5F101JL, R5F101LC, R5F101LD, R5F101LE, R5F101LF, R5F101LG, 

R5F101LH, R5F101LJ, R5F101LK, R5F101LL, R5F101MF, R5F101MG, 

R5F101MH, R5F101MJ, R5F101MK, R5F101ML, R5F101PF, R5F101PG, 

R5F101PH, R5F101PJ, R5F101PK, R5F101PL, R5F101SH, R5F101SJ, 

R5F101SK, R5F101SL 

G14 

R5F104AA, R5F104AC, R5F104AD, R5F104AE, R5F104AF, R5F104AG, 

R5F104BA, R5F104BC, R5F104BD, R5F104BE, R5F104BF, R5F104BG, 

R5F104CA, R5F104CC, R5F104CD, R5F104CE, R5F104CF, R5F104CG, 

R5F104EA, R5F104EC, R5F104ED, R5F104EE, R5F104EF, R5F104EG, 

R5F104EH, R5F104FA, R5F104FC, R5F104FD, R5F104FE, R5F104FF, 

R5F104FG, R5F104FH, R5F104FJ, R5F104GA, R5F104GC, R5F104GD, 

R5F104GE, R5F104GF, R5F104GG, R5F104GH, R5F104GJ, R5F104GK, 

R5F104GL, R5F104JC, R5F104JD, R5F104JE, R5F104JF, R5F104JG, 

R5F104JH, R5F104JJ, R5F104LC, R5F104LD, R5F104LE, R5F104LF, 

R5F104LG, R5F104LH, R5F104LJ, R5F104LK, R5F104LL, R5F104MF, 

R5F104MG, R5F104MH, R5F104MJ, R5F104MK, R5F104ML, R5F104PF, 

R5F104PG, R5F104PH, R5F104PJ, R5F104PK, R5F104PL 

G1A 

R5F10E8A, R5F10E8C, R5F10E8D, R5F10E8E, R5F10EBA, R5F10EBC, 

R5F10EBD, R5F10EBE, R5F10EGA, R5F10EGC, R5F10EGD, R5F10EGE, 

R5F10ELC, R5F10ELD, R5F10ELE 

G1C R5F10JBC, R5F10JGC, R5F10KBC, R5F10KGC 

G1D R5F11AGG, R5F11AGH, R5F11AGJ 

G1E R5F10FLC, R5F10FLD, R5F10FLE, R5F10FMC, R5F10FMD, R5F10FME 
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G1F 

R5F11B7C, R5F11B7E, R5F11BBC, R5F11BBE, R5F11BCC, R5F11BCE, 

R5F11BGC, R5F11BGE, R5F11BLC, R5F11BLE 

G1G R5F11EA8, R5F11EAA, R5F11EB8, R5F11EBA, R5F11EF8, R5F11EFA 

I1A R5F1076C, R5F107AC, R5F107AE, R5F107DE 

I1B R5F10MME, R5F10MMG, R5F10MPE, R5F10MPG 

I1D 

R5F11768, R5F1176A, R5F11778, R5F1177A, R5F117A8, R5F117AA, 

R5F117AC, R5F117BA, R5F117BC, R5F117GA, R5F117GC 

I1E R5F11CBC, R5F11CCC 

L12 

R5F10RB8, R5F10RBA, R5F10RBC, R5F10RF8, R5F10RFA, R5F10RFC, 

R5F10RG8, R5F10RGA, R5F10RGC, R5F10RJ8, R5F10RJA, R5F10RJC, 

R5F10RLA, R5F10RLC 

L13 

R5F10WLA, R5F10WLC, R5F10WLD, R5F10WLE, R5F10WLF, R5F10WLG, 

R5F10WMA, R5F10WMC, R5F10WMD, R5F10WME, R5F10WMF, 

R5F10WMG 

L1C 

R5F110ME, R5F110MF, R5F110MG, R5F110MH, R5F110MJ, R5F110PE, 

R5F110PF, R5F110PG, R5F110PH, R5F110PJ, R5F111ME, R5F111MF, 

R5F111MG, R5F111MH, R5F111MJ, R5F111PE, R5F111PF, R5F111PG, 

R5F111PH, R5F111PJ 

RX 

110 R5F51101, R5F51103, R5F51104, R5F51105, R5F5110H, R5F5110J 

111 

R5F51111, R5F51113, R5F51114, R5F51115, R5F51116, R5F51117, 

R5F51118, R5F5111J 

113 R5F51135, R5F51136, R5F51137, R5F51138 

130 R5F51303, R5F51305 

230 R5F52305, R5F52306 

231 R5F52315, R5F52316, R5F52317, R5F52318 

23T R5F523T3, R5F523T5 

24T R5F524T8, R5F524TA 

64M R5F564MF, R5F564MG, R5F564MJ, R5F564ML 

71M R5F571MF, R5F571MG, R5F571MJ, R5F571ML 

RZ 

T1 

R7S910001, R7S910002, R7S910006, R7S910007, R7S910011, 

R7S910013, R7S910015, R7S910016, R7S910017, R7S910018, 

R7S910101, R7S910102, R7S910106, R7S910107, R7S910111, 

R7S910113, R7S910115, R7S910116, R7S910117, R7S910118 
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3. Current Smart Manual support 

Smart manual support is delivered independently of e2 studio releases when available. The following devices 
are available as of the 21st of September, 2015: 

 

• RX62G 

• RX62T 

• RX63N 

• RX63T 

• RX64M 

• RX71M 

• RX110 

• RX111 

• RX113 

• RX210 

• RX220 

• RX631 
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4. What is new in 4.2.0? 

 

Component Description 
Synergy 
Support 

e² studio 4.2 will be the first version of the product to support the new Renesas Synergy 
Family.  This will have a lot of specific functionality to support the ARM Cortex M series 
devices.  Initially supporting the S3A7 and S7G2 group of devices on the ARM Cortex M4. 

The functionality provided will create ARM Launchpad GCC and IAR ARM toolchain 
Synergy projects which can create, configure and debug projects using SSP (Synergy 
Software Platform) components. Note, you can download the ARM Launchpad GCC using 
the web based e² studio installer. 

The SSP is a driver model which delivers both HAL drivers and framework drivers providing 
higher level services for customers to use in their end applications.  These framework 
drivers are built on top of the ThreadX RTOS.   

Before you try and use the Synergy project generator you need to ensure you have a valid 
license and the latest version of the SSP. 

To download the latest version of the SSP please go to The Synergy gallery website to 
register and download: https://synergygallery.renesas.com 

The Synergy project generator is available via [File->New->Synergy Project]. 

To use the system you need to browse to a license file which can be downloaded from the 
gallery. 

Once the project is created and editor is displayed which allows the configuration of the 
Synergy project and SSP code. 

 

Project generation 
 

A fully featured project generator will be implemented to create Synergy projects for GCC 
and IAR.  This allows selection of the device, board, toolchain version and debugger.  This 
project generator is launched via the [File->New->Synergy Project] menu item. 
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Once these are selected a project templates page is shown that allows you to choose a 
suitable template to start building your project from.   

 



e2 studio 4.2.0 Release Note 

Rev 1.2, Dec 9th, 2015  Page 13
  

 

 

 

Editing and configuring projects 
 

Once created the configuration file will be loaded into the e² studio, this file is a XML file but 
when opened in the editor it shows a graphical editor of the file.  Initially when opened e² 
studio opens the Synergy Configuration perspective giving maximum screen space for the 
Synergy editor plugins. 

Initially the summary page is opened but there are various other tabs available in the editor: 

BSP 

This tab allows you to change the selected board or device.  When this tab is in view the 
properties view also shows the properties for the BSP code.  Changing these values will 
modify header files when the code is generated which configure the BSP software module. 
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Clocks 

The clocks tab allows you to configure the clock frequencies for the device.  This data is 
used to generate the clock header file for the BSP when the code is generated.  

 

 

 

Pins 

The pins view allows you to configure the pin configuration for the device.  This can be 
achieved via the package view or via the editor view.  

There is also a pin conflict view which shows problems in an easy to reach view which 
relate to pin setup. 
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Threads 

The threads tab is where the main configuration of the project source code occurs. Here 
the user can create RTOS threads, create RTOS events, add modules to a thread and 
configure modules.   

 

 

When the code is generated the files are created or overwritten on the basis of the settings 
made. 

 

ICU 

This tab allows you to configure the interrupts in their project.  All interrupts in the system 
are listed.  Selecting an interrupt allows the user to enable and specify the priority of the 
interrupt. 
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Interrupts can also be configured from the properties window for the selected module in the 
threads tab. 

 

 
Generating and building code 
 

There are two methods for the code to be generated.  There is a generate code button 
within the editor, there is also a builder implementation.  This builder regenerates the editor 
source files when the settings have been modified on a standard Synergy build operation. 
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Debugging 
 

The debugger for the Synergy platform is the Segger J-link.  This has been implemented 
for the CM4 and CM0+ devices.  In addition functionality such as Semi-hosting has been 
added to extend the already existing ARM e² studio debugger. 

Also support has been added to the Partner OS to support Thread X and integration to 
TraceX also added to the product. 
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5. Useful workarounds and information for 4.2 

 

ID Component Workaround or information 
 Application This version of e2 studio is based on Eclipse Luna SR2 and CDT 8.6.  This 

release note does not describe the Eclipse framework and CDT plugin issues 
and fixes. You can find the detailed information on the sites below: 
 
For information on the Luna release see here: 
https://projects.eclipse.org/releases/luna 
http://archive.eclipse.org/eclipse/downloads/drops4/R-4.4-201406061215/news/ 
 
 
CDT: 
https://wiki.eclipse.org/CDT/User/NewIn86 
 
The Eclipse bug tracker is here: 
https://bugs.eclipse.org/bugs/ 
 

 
The bug list for Luna is available using the following query:  
https://bugs.eclipse.org/bugs/buglist.cgi?bug_status=RESOLVED&bug_status=V
ERIFIED&bug_status=CLOSED&classification=Eclipse&list_id=12238007&prod
uct=Platform&query_format=advanced&resolution=FIXED&target_milestone=4.4
&target_milestone=4.4%20M1&target_milestone=4.4%20M2&target_milestone=
4.4%20M3&target_milestone=4.4%20M4&target_milestone=4.4%20M5&target_
milestone=4.4%20M6&target_milestone=4.4%20M7&target_milestone=4.4%20
RC1&target_milestone=4.4%20RC2&target_milestone=4.4%20RC3&target_mile
stone=4.4%20RC4&target_milestone=4.4.1&target_milestone=4.4.2 
 
Bug List for CDT is:  
https://bugs.eclipse.org/bugs/buglist.cgi?bug_status=RESOLVED&bug_status=V
ERIFIED&bug_status=CLOSED&classification=Tools&list_id=12238014&produc
t=CDT&query_format=advanced&resolution=FIXED&target_milestone=8.5&targ
et_milestone=8.6.0 
 
 

5954 Application If you experience the error message “org.eclipse.swt.SWTError: No more 
handles” this can be caused by certain multi-monitor software and the Eclipse 
framework. 
 
If this error occurs there are 2 workarounds: 
 

1. Use a single monitor display. 
2. Uninstall the multiple monitor software from your graphics chipset 

vendor and revert to the standard Windows multi-monitor feature. 
 

6981 RL78 
Debugging 

When debugging IAR C source file with an OCD emulator (E1), the Monitor 
program area (0x00002-0x00003) is used. 
 
So this area must be excluded from usable address space. Please add '-HFF' in 
the linker option. 
 
- Open Property. 
 
- Select [C/C++ build]-[Settings] at left side. 
 
- Select 'IAR RL78 Xlink linker' at right side, add '-HFF' at the textbox 'command'. 
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Not doing this will cause problems with connection and download when using 
interrupts. 

NA Application If you are experiencing slow building of projects within e2 studio there are some 
possibilities to improve. 

The system environment will attempt to find the make.exe tool via the system 
environment.  If you ensure the directory make resides in is at the start of the 
path variable it will find it more quickly.  Especially important if there are network 
drives in the path. 

In the project properties, C/C++ Build tab, behavior tab you can switch on 
parallel build.  This will take advantage of the multi-cores on your host machine if 
it has them.  In e2 studio 2.1 or later this now defaults to on for new projects. 

NA RZ GCC In 3.0 the KPIT GCC RZ toolchain was support at version 14.01.  This version is 
no longer supported within e2 studio. 

KPIT have modified the name of their ARM toolchain to be ARM-none-eabi to 
follow standard ARM naming convention like other GCC toolchain vendors. 

The toolchain is available at version 14.01 and 14.02 from the KPIT website. 
The binaries in the 14.01 version is identical to that used in the 14.01 RZ 
toolchain. 

Once the toolchain is installed your projects will be imported and ported to 
ensure there is as little disruption as possible due to this change. 

NA GCC Build 
Plugin 

The GNU toolchain linker file format was changed in 3.0.  This means projects 
that are developed in 3.0 or later and opened in 2.x will still continue to build.  
However you may experience issues visiting the GCC Linker Sections user 
interface. 

5041 Code 
Generator 

Code Generator can delete user code between /* Start */ End comments in 
some situations. 
Using the code generator if the following code is placed in the main function:  
//if(data_in!=0xAA){  
On a line by itself, all of the main code will be removed when Generate Code 
button is pressed. 
The key issue is that the {brace is on the same line as the comment. 

2010 HEW 
Importer 

Symptoms: Project fails to build after import from HEW 

Conditions: If a long filename or path is used, and the HEW project importer is 
used, the project may fail to build. 

Workaround: Move the original HEW project to a shallow directory structure (i.e.) 
C:\Workspace and import from there.  Also ensure that the HEW project is 
relocated before importing into e2 studio. 

2421 Debug 
Configuration
s 

Debug configurations have been modified since e2 studio 2.x.  So although you 
can re-use the workspace and projects from e2 studio 1.x when you open the 
debug launch configuration for the first time it is updated. 

Before doing this you should back-up the .launch file if you need to keep a 1.x 
version. 

NA Application It is not possible to import e2 studio 1.x projects which are for the V850 device 
into e2 studio 2.0. 
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1922 Application Symptoms: Project fails to build in first instance after archive project import (not 
from HEW) 
 
Conditions: If an archived project is imported it may fail to build the first time, due 
to a residual .d file. 
 
Workaround: Clean and Build a second time. 
 

2762 CODAN When using assembly code within a C source file, Codan errors can be 
observed in the editor. Even though the project builds successfully. 
 
We do not have a workaround for this at this time. 
 
On occasion you may also see this for C source files.  This is normally a case of 
the indexer needing to be refreshed. 
 
Right click on the project, select Index->Freshen all files.  Then right click again 
select Index-Rebuild.  This should solve unexpected CODAN errors in C source 
files. 
 

2728 GDB Step into does not always work when using the CCRX 1.02.01 toolchain. 
 
To ensure this behaves correctly you will need to use CCRX 2.00.00 or greater 
as this issue with the debug information is corrected in this release. 
 

NA Eventpoints If eventpoints do not always work just after they are set, you can use the "Apply 
to Target" toolbar button in the Eventpoint view to send the Eventpoints to the 
target manually.  This will always ensure the debugger target has all the required 
eventpoint updates before execution starts. 
 

5772 IAR Plugins The IAR Plugin Manager is now included in e2 studio.  This provides support for 
RX, RL78, RH850 and RZ (ARM). 
 
This is a tool which simplifies installation and configuration of IAR toolchain 
plugins. You can access this though Help -> IAR Embedded Workbench plugin 
manager. 
 

5903 Code 
Generator 

For the following RL78 code generator project, "Peripheral Functions" view tabs 
may not be operated with double-clicking "Peripheral Functions" branch of 
Project Explorer view. 
 
After creating/loading the project, please show "Code Preview" view by double-
clicking of "Code preview" branch at Project Explorer tree at first. Then, please 
access Code Generator setting tabs by double-clicking Project Explorer tree or 
using pull-down menu by pressing triangle button at the up-right corner of 
Peripheral Functions view. 
 
RL78/G12, RL78/G13, RL78/G14, RL78/G1A, RL78/I1A, RL78/F13, RL78/F14, 
RL78/F12, RL78/L12 

6184 RL78/CCRL 
debugging 

When the load module for RL78/G10 which created at CC-RL is debugged in E1, 
please specify the following option: 

[Linker] -> [Device] -> "Set enable/disable on-chip debug by link option 

5995 CCRX to 
GNU RX 
Converter 

When converting from CCRX to GCC projects some comments like //* comment 
*/ are left intact which will result in an error if standard is set to C89. Changing 
the standard to C99 or above will fix this problem. 
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7217 Application The restore default settings does not restore all of the options set during project 
generation.  Instead it sets the defaults to the base settings for the device family 
in use. 

7524 RZ/T1 
Debugging 

In a RZ/T1 RAM-based project, the "Reload" function does not work. 

Reloading or re-downloading during debugging resets the device and the RAM 
content is erased. 

To continue the debugging, disconnect and connect the debugger again. 

 RZ/T1 
Debugging 

HVA0 register writing is needed in VIC register initialization by updating user's manual of 
RZ/T1. 

 

void icu_init(void) 

{ 

     /* Initialize VIC (dummy writing to HVA0 register) */ 

          VIC.HVA0.LONG = 0x00000000;  

 

     /*******************************************/ 

     /*      Set IRQ pin interrupt 5(IRQ9)      */ 

     /*******************************************/ 
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6. Fixed issues in 4.2.0.12 

ID Component Description 

7180 

CodeGenerator plugin 

RX64M code generator 

 

Multi-function timer pulse unit 3 

 

When TGRC0, TGRD0 and TGRE0 is set to buffer register mode in normal 

mode, TMDR1 register setting is incorrect. 

 

Currently 

 

 MTU0.TMDR1.BYTE = _00_MTU_NORMAL;  

 

Correct 

 

 MTU0.TMDR1.BYTE = _00_MTU_NORMAL | _10_MTU_BFA_BUFFER | 

_20_MTU_BFB_BUFFER | _40_MTU_BFE_BUFFER 

 

Please add the missing code manually.  

 

7288 

CodeGenerator plugin 

Code Generator for RX231, RX230 

 

1. RX231 and RX230 devices more than 100pin have Open Drain setting for 

PORT J. But, Code Generator doesn't support Open Drain item on PORT GUI.  

 

2. RX230 devices have the following pins. But, Code Generator doesn't 

support items for them. PORT H cannot be set as I/O port and other 

multiplexed pin functions. 

 

PH0/CACREF, PH1/IRQ0/TMO0, PH2/IRQ1/TMRI0, PH3/TMCI0 

 

3.PinView (Pin List, Top View) is not supported about the following RX231 

devices. 

 

48pin: 

 

 R5F52315CxNE, R5F52316CxNE, R5F52315CxFL, R5F52316CxFL 

 

 64pin: 

 

 R5F52315CxND, R5F52316CxND, R5F52315CxFM, R5F52316CxFM, 

R5F52315CxLF, R5F52316CxLF 

 

 100pin: 

 

 R5F52315CxLA, R5F52316CxLA, R5F52315CxFP, R5F52316CxFP 

 

4. At RX231 and RX230. When MTU2 is used with Complementary PWM 

Mode n, build error occurs because of no macro definition.  
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7336 

CodeGenerator plugin 

KPIT GNURX toolchain: 

 

"interrupt" attribute keyword in r_cg_interrupt_handlers.h is missing from 

the following interrupt functions.   

 

Please add keyword "interrupt" to attribute of prototype declaration. 

 

example:   

 

{{{void r_tmr_cmia0_interrupt(void) __attribute__ ((interrupt));}}}  

 

 

RX113 CMT,CMPB,TMR,SCI,RIIC 

 

RX23T S12AD,CMPC 

 

RX231 DMAC,ELC,TPU,TMR,CMT,SCI,RIIC 

 

The problem of missing of "interrupt" is, the interrupt function returns by 

the mnemonic "RTSD". 

 

The interrupt function should return by "RTE". 

 

  

7434 

CodeGenerator plugin 

RX230, RX231, RX23T Code Generator 

 

There is a build warning when using CC-RX toolchain project. 

 

Because Code Generator adds the unnecessary section "FIXEDVECT" into 

Linker option.  

 

Warning Message: W0561100: Cannot find "FIXEDVECT" specified in option 

"start" 

 

7641 

Memory Usage plugin 

RX71M and RX64M project cannot display the RAM/ROM usage information 

in the memory window. 

 

After users select the RX71M project, then select another projects, the 

ROM/RAM usage cannot be displayed either. 

 

7724 

CubeSuite+ 

importer/exporter 

'''Problem''' 

 

Regarding the CC-RL project: 

 

Export project does not output the following combination option correctly. 

 

 * Specify [Linker]>[Input]>"Relocatable files, object files and library files" 

 

 * Specify [Linker]>[Input]>[Advanced]>"Use custom linkage order" 
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7849 

CodeGenerator plugin 

FIT modules cannot be uninstalled from the project when executing source 

code in FIT configurator after removing FIT module from the selected 

modules list in FIT configurator. To uninstall FIT modules from your project, 

remove the folder of each FIT module you want to uninstall manually in the 

project explorer. 
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7. Open issues in 4.1.0.12 
 

ID Component Description 

874 GDB server RX 

Execution Address Eventpoints with trigger count do not work with Breakpoints on Segger 
RX. 
 
Setting an execution address eventpoint with a trigger count on Segger JLink RX62N is not 
possible if any breakpoints exist, including the default at main. 
 
If an execution address eventpoint with a trigger count is set with a breakpoint both the 
eventpoint & the breakpoint do not function. Multiple breakpoints are set then only 1 does 
not work. Additional eventpoints function as normal. 

1486 Application Breakpoint properties do not work when set in the CDT dialogs.  For example using the 
filter operation and removing the breakpoint for the process being debugged. 

1616 RX GCC build plugin The options of a Build Configuration were not correct after specifying Multiple 
Configurations... functionality. 

1642 Application 

Erase flash on start-up option on RL78 should be executed once. 
 
When e2studio connects successfully to RL78 target and erases the flash, this option 
should return to false, so that flashing is not done every time target is connected. 

1778 Application 

When setting the 'Internal Flash Memory Overwrite' debug option, it is possible to exceed 
the maximum number of non-continuous memory blocks supported. No warning is given if 
this limit is exceeded. 
 
 
 
When setting this option ensure the limit (16 for RX devices) is not exceeded. 

1808 HEW Project 
Converter 

Import a HEW RX project in e2studio using the HEW project importer. 
 
Check: Project > Properties > Compiler > Source > Include file directories.  Paths are 
duplicated 

1859 GDB server RX 
Program execution stops inside a range when Range Exclusive is specified in the address 
settings for OA event points. 

1889 Application 

Due to file extension issue with .s and .S and due to known bug, e2studio users will not be 
able to use .s or .S effectively to pre-process assembly files that need GCC. Hence we  
suggest renaming these files to use: 
 
 
 
.S -> .asm 
 
.s -> .src 
 

1982 CCRX Build plugin For Renesas CCRX the Converter phase gets invoked even when using the external linker 
subcommand option.  This should not happen. 

2299 RX GCC build plugin 

It is possible for .c and .C files to be treated in the same manner in certain situations which 
is not correct. 
 
(.C extension is changed to .c during project build). 
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2416 Project Generation 

Use of duplicate register is allowed for RXC project generation. 
 
 1. Create RXC project 
 
 2. Go to RXC Global option page, select "ROM" -> "R8" 
 
 3. Select the same value for any other register (e.g. "RAM" -> "R8"), it gives error message 
and prevents the user from project creation. 
 
 4. Now select "R8" again for "RAM" register. It doesn't show any error message and allows 
user to create the project. 

2486 Profile plugin Acquiring profile results can take a very long time following RX Simulator debugging. 

2537 Performance Analysis 

Performance Analysis: Performance time is not updating following changes to start and 
stop performance addresses. 
 
For the G13 IEcube it supports one run/break timer.  Currently e2 studio is setting the 
support to 3. 

2716 GDB server RL78 Before PC events on IECube has a hard coded limit of 4. 

2762 Application When using assembly code within a C source file, Codan errors can be observed in the 
editor.  Even though the project builds successfully. 

2859 CDT When using IAR projects the SFR names (e.g. PIOR1_bit.no1) are not understood correctly 
in the editor. 

3389 Application 
When debugging files with the same name show source addresses even though it may not 
be correct for the file in question.  The full file path is not considered just the filename and 
current debug context.  This can lead to e2 studio showing addresses unnecessarily. 

3526 Profile plugin In some cases when using RX with the CCRX compiler the profile view does not display the 
source file name and path in the window. 

3626 Trace plugin Snapshot trace - adding IO register eventpoints increases the data shown in the trace view, 
but as they were removed there was no change in the data shown. 

3663 Application 

With 2 targets connected, clicking between the two debug contexts in the Debug View will 
update the source addresses in the open Editor files. 
 
However changing debug context does not seem to get detected if clicking on the top-level 
of the debug context rather than on the lower level.  

3928 CCRX Build plugin 

By default the e2 studio editor character code is set to UTF-8.  This means it is possible to 
enter characters that are then not supported by default by the CCRX toolchain. 
 
CCRX default input is SJIS. 
 
To enable UTF-8 for the toolchain you must first select C99 support. 

3950 Application 

Breakpoints cannot be unset within the editor when code is #ifdef out. 
 
These breakpoints will need to be removed from the breakpoints plugin. 
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4189 Project Generation It is not possible to build project which has more than 98 characters in its project name. 

4191 GDB server RX 

When using Segger JLink, with the "Force Hardware Breakpoints" debug option enabled, 
adding more than the maximum amount of breakpoints for a device and then removing 
some can lead to none of the breakpoints firing. Workaround is to add a single breakpoint 
back in to trigger the reapply of all others. 

4350 CubeSuite+ 
importer/exporter 

When importing a project from CubeSuite+ to e2 studio the “toolchain version is changed" 
dialog is always displayed. 
 
This is because the version string in imported project file and the toolchain information in e2 
studio does not match.  Ignoring this dialog and continuing should result in a successful 
import. 

4438 Application 

The e2 studio debugger (GDB) does not deal correctly with this RL78 mnemonic. It uses 
the wrong instruction code: 
 
Mnemonic: DIVWU 
 
Instruction code: (Wrong) CEFB04 
 
(Correct) CEFB0B 

4450 CCRX Build plugin 
Linker section settings of Renesas toolchain are not getting saved for multiple 
configurations. 

4492 Application The Module View of e2 studio does not display any information when an executable which 
includes debug information was downloaded to the target. 

4515 CCRX Build plugin 
When building projects with CCRX that are in deep directory structures it is possible to 
experience build issues.  e2 studio is unable to build projects which create command lines 
greater than 8191 characters. 

4597 Application In some cases when a before PC eventpoint is set just after a break point, the program 
execution will not stop at the address the eventpoint is located at. 

4607 GDB server 

When sub menu "Add Watchpoint" is performed from a Memory view, it seems to have 
been registered correctly in the Breakpoints view even if there is an error condition. 
 
An error occurs by "Add Watchpoint", when the maximum number of events was exceeded, 
or when a ROM area is specified. 

4783 Performance Analysis 

The option to Reset timer before each run, which is setup on the "Performance Analysis" 
dialog box is not reflected for RL78. 
 
The specification for RL78 is that the values are reset all of the time so the option has no 
meaning.    

4819 CCRX Build plugin Individual compile is not execute when Level2 is specified at the "Perform inter-module 
optimization". 

4869 Memory View plugin The "Memory" view always opened on launch of a debug session. It should not be re-
opened on launch if it has been closed in the previous debug session. 
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4982 GDB server RX When a data access event for RX is set with the data mask value as 0, the comparison will 
be treated as "Equals" and the data mask value will be treated as 0xFFFFFFFF. 

5041 CodeGenerator plugin 

Code Generator can delete user code between /* Start */ End comments in some 
situations. 
 
Using the code generator if the following code is placed in the main function:  
 
//if(data_in!=0xAA){  
 
on a line by itself, all of the main code will be removed when Generate Code button is 
pressed. 
 
The key issue is that the { brace is on the same line as the coment. 

5083 CubeSuite+ 
importer/exporter Folder level options are not converted correctly 

5124 Application Active configuration lost while importing project (which is exported as file system). 

5171 CCRX Build plugin 
Files included in the Pre-include build options are not analyzed for the pre-processor 
statement in the editor.  This can give the impression that code is not included in the build 
when it is. 

5179 CubeSuite+ 
importer/exporter 

When CubeSuite+ project imports to e2 studio, Build cannot perform sometimes. 
 
[Workaround] 
 
Please add the <root folder> to "C/C++ General -> Paths and Symbol -> Source Location" 

5201 Application 

If you create a project and debug session for a GDB simulator before executing a hardware 
debug session it will fail.  This is because the debugger support is not unpacked until a 
hardware debug session is used. 
 
To work around setup and launch a hardware debug session.  You do not actually need 
hardware to do this. 

5290 CCRX Build plugin 

When you add a new configuration, please do not specify 'Default Configuration' as a 
configuration used as a base. 
 
If you specify the 'Default Configuration', the configuration which does not operate correctly 
is created. 

5467 Memory View plugin Settings in the 'Format' dialog (Memory view) are not restored. 

5547 GDB Server RH850 

 

To use the data access events as trace start, trace stop or trace record for RH850 with E1 
emulator, please do not use the "Compare Settings" condition for the event. 
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5551 Application 
If the maximum number of break points are used for RX with E1/E20 emulator, the 
connection or the program execution may fail. In this case, please reduce the using break 
points. 

5632 Multicore When using multicore projects the Debug View may show an incorrect name for the second 
loaded module (as a duplicate of the first) 

5637 Multicore For RH850 multicore devices, disassembly result may be different from the expected. In 
this case, please refresh the view after changing the debug context to the other PE. 

5668 Coverage plugin In some cases when using the Coverage facility with the RL78 IECUBE some lines are 
shown as 'branch' or partial coverage when they should be 100% covered. 

5669 GDB server 
An invisible breakpoint is left in the project following a ‘Move To Line' operation.  Program 
execution continues to halt at this location once the Move to Line operation has been 
performed. 

5721 CDT When modifying code that changes the line an already set breakpoint is located at the 
breakpoint is not moved according to the modification. 

5770 Application 

RX targets and IO registers greater than 1 byte. 
 
e.g. 
 
winA 0x88028 
 
winB 0x8802a 
 
View register in both IO view and register view. 
 
Value in memory view is reversed. 
 
This is because the IO, (like all RX memory for little endian targets is reversed). 

5852 Application PC set in the debug configuration is not set following launch for the Renesas RX and GDB 
RL78 simulators. 

5911 DS-5 importer The current DS-5 importer in e2 studio imports KPIT GNU "Application" project types only.  
Other projects cannot be imported at this time. 

6208 GDB server RX 

When debugging with RX there are problems with setting breakpoints when the hardware 
breakpoint resources have been exhausted and the software breakpoint setting also fails. 
 
In this case the breakpoint appears to be valid but the debugger will not stop. 
 
This can often be seen when the option "Program re-writes internal Data Flash" is set to 
yes.  As this means software breakpoints cannot be set. 

6350 Application 

NullPointerException is observed when adding a custom configuration and selecting the 
same configuration within the â€˜Multiple Configuration' selection at the same time. 
 
This issue only occurs if user has not applied after creating new configurations:  
https://bugs.eclipse.org/bugs/show_bug.cgi?id=352047 

6394 GDB server RX Trace Record event point does not filter correctly with Segger RX63N. 
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6408 Debug Configuration 

When User boot mode is selected at the setting for Mode pin in CPU Operating Mode, the 
warning for USB boot program is displayed even if the device does not have USB boot 
program. 
 
Please click 'yes' if the device does not have USB boot program. 

6450 Application 
When "Prevent debugger from re-writing on-chip Program ROM" is checked and "Force 
Hardware Breakpoints" is set to No setting breakpoint fails and the program will not 
execute. 

6463 Application Memory view requires manual refresh to see changes when downloading auxiliary file. 

6484 Application 
Additional build tabs contributed by other third party tools can be hidden by e2 studio. 
Â This is caused by Renesas/KPIT build plugins replacing the standard build settings page 
with a custom one. 

6529 CDT After restart on occasion the disassembly window can be empty. Refreshing the window or 
stepping works around the problem. 

6549 GDB server RX The Profile View 'Execution Time' and 'Average Execution Time' columns are showing as 
zero after suspending the current debug session (for all targets). 

6557 GDB Server RH850 Breakpoints are not always being cleared completely when a breakpoint is removed. 

6566 Real-time Watch In some situations the RH850 multicore real-time expression update does not work. 

6605 Event points plugin 

The enable state of eventpoints for any debug configuration is not restored when the debug 
configuration is launched for the first time after e2 studio is started. 
 
In subsequent launches the eventpoints are enabled/disabled appropriately.  

6616 Event points plugin 
When adding a new Data Access eventpoint, the Compare value (on the Data Access 
Settings tab) is always converted to hex and subsequently displayed in hex even if the 
value entered does not include an 0x prefix. 

6657 Coverage plugin 

If the workspace is copied or moved from the original folder, coverage information may not 
be displayed. 
 
Please re-build the program in the new workspace. 

6701 GDB server RX 

For RX devices, when 'step' command is invoked for WAIT instruction, GDB might report an 
error. 
 
Please use 'resume' command for WAIT instruction instead. 

6704 Profile plugin For RZ/T1 target a user can select Profile View. When selecting button 'Turn Profiling On' 
this is allowed to be enabled although this is not supported. 

6817 Waveform plugin If address of variable is changed then this address should be updated in waveform view as 
well, but it is not so. 

6852 Project Generation 

Combination of "C++ project" and "CC-RL" toolchain is selectable. 
 
But, "CC-RL" toolchain does not support "C++ project". 
 
So, do not select the combination of "C++ project" and "CC-RL" toolchain. 
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6859 CDT 
In some cases after reload symbols are not being updated correctly.  Appears to be related 
to caching with CDT. GDB symbol information is correctly updated, and expressions which 
directly access fields in structures updated correctly, but overall structures are not correct. 

7005 Application 

Debugging with the RL78 GDB simulator with the IAR project generators is not straight 
forward. 
 
The default IAR debug configuration uses the GDB executable name "GDB". 
 
This launch will not work and you need to point it at "rl78-elf-gdb.exe" included in the e2 
studio debugcomp directory. 
 
However if you have not launched a Renesas debug configuration it won't be present. On 
the first launch of a Renesas debug configuration for RL78 the file is uncompressed from 
the package zip file. 
 
So to work around you need to launch a RL78 E1 session first so the GDB application for 
RL78 exists. 

7057 Event points plugin When adding an event point to an external source code file. (File added using "Link to file in 
the file system" option). There can be problems adding the event point in this case. 

7277 IAR plugins 

In some cases the IAR project importer does not perfectly import all set build options. 
 
One example is the -HFF command line option that can be specified in the command line 
options text box for the linker. 

7298 Application 

When font size is changed as magnified, some of components of the dialog can be hidden 
with magnified fonts. 
 
In this case, please resize and expand dialog size.  

7305 Application The build throws an exception when setting '-no-keep-memory' and '-mrelax' options at the 
same time for a GNURX project. 

7333 Real-time Watch 

When using the RX Simulator with real-time expressions if you use 1ms real-time interval 
the expression view goes blank.  On suspend, e2 studio appears to hang while messages 
are processed. 
 
Reverting the interval to 10ms works well. 

7351 Trace plugin 
Trace view should maintain Filter and Find settings to each ADM debug context. 
When changing debug session in [Debug] view, Filter and Find settings is set to default 
value. 

7355 GDB server RX 

When connecting to RX63x, RX64x, RX7xx, RX2xx, or RX1xx with user-boot mode, it will 
fail. 
 
Please do not use user boot mode for these devices. 

7380 GDB server RX 

When connecting with RX simulator, Profile view does not show any information. 
 
Profile view sometimes show some information, it is not correct information. 
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7403 CDT 
The setting 'Use a fixed build configuration' in the dialog, Properties->C/C++ General-
>Indexer is not saved when the user checks it. 
 

7412 GDB server RL78 

When using RL78 the HL register value cannot be modified in some circumstances. 
 
This will only occur when bank 0 is not selected. 
 
Changing HL value only ever causes Bank 0 HL to change. 
 
View will always show current bank value. 
 
Values not in bank 0 can still be changed by accessing bank registers directly. 

7423 CDT 
In some cases the disassembly view does not refresh correctly on suspend.  When this 
problem happens the refresh operation does not fix the problem. To restore the functionality 
close and re-open the view. 

7456 GDB server RL78 

The option "Low voltage OCD board" in the debug configuration for RL78 E2 Lite is not 
supported. 
 
Please don't set this option to "Yes". 

7457 GDB server RL78 
The option "Hot Plug" in the debug configuration for RL78 E2 Lite is not supported. 
 
Please don't set this option to "Yes". 

7468 GDB server RX When using the RX Simulator the trace view does not show correct source and 
disassembly information when these two modes are enabled. 

7491 Application The Insert Spaces for Tab feature in the Eclipse editor does not work.  This is an Eclipse 
platform issue. 

7497 CCRX Build plugin 

'''Problem''' 
 
When a project which specifies MISRA-C option changed the toolchain version, the MISRA-
C option is deleted. 
 
'''Workaround''' 
 
Please re-specify the MISRA-C option. 

7498 Application 

Multi-byte characters can cause a compilation failure when used as a build configuration 
name in e2 studio. 
 
Therefore, multi-byte characters should NOT be applied to debug/build configuration 
names. 
 
Note: This issue affect both for configuration management dialog and the configuration 
creation dialog of Optimization Assistant. 

7508 Application 

'''Problem''' 
 
An error occurs by project operation when the character besides ASCII cord was used for 
the file name or the folder name. 
 
'''Workaround''' 
 
Please don't use the character besides ASCII cord for the file name or the folder name. 
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7524 GDB Server RZ 
For RAM based RZ-T1 projects a re-download of code will trigger a reset that erases the 
RAM making further debugger operation impossible. The workaround is to instead 
disconnect and then reconnect. 

7533 Performance Analysis Performance Analysis view does not show time result (even 0) if the time taken is very 
short (less than 1 unit of the emulator or device). 

7546 Smart Browser 

PDF file is associated with Microsoft Edge by default in Windows 10. 

However, Smart Browser and Smart Manual will not be able to recognize that the Microsoft 
Edge is associated with a PDF. 

Please install the PDF viewer such as Adobe Reader and specify the application of default 
to open the PDF file. 

7547 Smart Manual plugin 

PDF file is associated with Windows Edge by default in Windows 10. 

However, Smart Browser and Smart Manual will not be able to recognize that the Windows 
Edge is associated with a PDF. 

Please install the PDF viewer such as Adobe Reader and specify the application of default 
to open the PDF file. 

7570 Application 

Iodefine.h files for RX230 and RX231 were incorrect about portj. 

st_portj.ODR0.BIT.B3 is incorrect. 

st_portj.ODR0.BIT.B6 is correct. 

Please correct it as follows. 

---<incorrect>--------------------------------------------------------- 

struct st_portj { 

   : 

 union { 

 unsigned char BYTE; 

 struct { 

 unsigned char :4; 

 unsigned char B3:1; <-- B3 does not exist. 

 unsigned char :3; 

   } BIT; 

 } ODR0; 

 : 

} 

----------------------------------------------------------------------- 

---<correct>----------------------------------------------------------- 

struct st_portj { 
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        : 
 
    union { 
 
        unsigned char BYTE; 
 
        struct { 
 
            unsigned char :1; 
 
            unsigned char B6:1; 
 
            unsigned char :6; 
 
        } BIT; 
 
    } ODR0; 
 
        : 
 
} 
 
----------------------------------------------------------------------- 

7572 TargetInformationTool 

GNURL78 (G10 - R5F10Y14): Project build fails for debug configuration when using the 
GDB simulator. 
 
G10 - R5F10Y14 has a small RAM area. We need to reduce the stack size limit. Reducing 
the stack size limit from 0x64 to 0x32 (i.e. modifying PROVIDE (stack_size = 0x64) to 
PROVIDE (stack_size = 0x32) in the linker script) builds the project successfully. 

7588 Application 
Start / Stop Function Settings for RL78 are sent once on connecting. If the address for start 
function or stop function is changed by building the program, please disconnect from target 
and reconnect again. 

7592 GDB server RL78 
For RL78 E2 Lite, please use RESET# for the pin which has multiple functions of both 
RESET# and PORT. 

7597 IAR plugins When cleaning a Synergy project which uses the IAR toolchain, the clean can fail with a 
"Command-line too long" error. 
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7607 RL78 GCC build plugin 

When creating a GNU RL78 project for the RL78 G13 device.  Changing the optimization 
settings can cause the -mmul option 'Use RL78 hardware multiply instructions for G13' the 
build settings. 
 
Re-visit the build settings and re-enable this option if it is desired. 

7619 CCRX Build plugin 

'''Problem''' 
 
When the [C/C++ General] > [Paths and Symbols] > [References] is specified, Build 
warning occurs. And, .x file is not created at the time of using Renesas Toolchain. 
 
'''Workaround''' 
 
When you'd like to use the project dependency, please specify a child project in [Project 
Reference]. 

7628 CodeGenerator plugin 

When using the code generator on Turkish windows there can be an issue which can cause 
an exception. 
 
This is caused by the letter 'I' not being processed correctly within the code generator. 
 
Swapping to use English region solves the problem. 

7660 RL78 GCC build plugin 

Project build fails for RL78 GCC when adding the __far keyword in the code. 
 
To fix this issue, you need to add the PROVIDE (__rl78_abs__ = 0) macro in your RL78 
linker scripts. 

7689 CCRX Build plugin When using the Renesas CCRX toolchain the -space option of linker cannot be specified. 

7720 GDB Server RZ 

The Cortex M3 does not stop at entry address when multicore debug is performed. 
 
When the debugger connects to the CM3 core, the CM3 core runs for a short time. 
 
The Segger J-Link log shows the Cortex M3 core is not halted and it runs for a few ms 
when the debugger connects to the CM3 core. 

7729 CDT 

Renaming header files within the e2 studio IDE can affect the ordering of the dependency 
scanning. 
 
After renaming the header file is modified to be inside <> instead of "" and is placed at the 
top of the file. 

7739 GDB Server RH850 Real-time memory refresh for RH850 will terminate the program execution shortly. 
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7755 Device Support RX 

Memory Usage view is not available with the projects for RX230 and RX231 groups. 

RX23T group's project may not able to obtain accurate results because address range 
0x00004000 - 0x00004A7F is regarded as out of memory. 

Memory Region configuration features are not available for RX230 and RX231 groups.   

On RX23T group's project, address range between 0x00004000 and 0x00004A7F is hidden 
on configuration dialog.  

On RX634 group's project, address ranges of IO register are hidden. 

7761 Application The linker map file for the RZ GNU can be generated as the wrong name when it is 
created. 

7807 Performance Analysis 

Timer 1 and Timer 2 show same result value in Performance Analysis view although timer 
start event and timer stop event are different between Timer 1 and Timer 2. 

In this case, please use only Timer 1. 

7809 Event points plugin 

Some event points are sometimes duplicated in Event points view when re-connecting to 
debugger. 

In this case, please connect to debugger again or delete duplicated event points and create 
event points again. 

7818 HEW Project 
Converter 

[Problem] 

(Import project from HEW) 

When a project which the debugging option is specified by HEW is imported, the debugging 
option is lost. 

[Workaround] 

Please re-specify the debugging option to a project. 

7826 CodeGenerator plugin 

In the case where a workspace has several projects including Code Generator, the 
confirmation dialog to save Code Generator settings appears one time when exiting e2 
studio, and settings for only the active project is saved.  

The Code Generator settings of other projects are lost. Please select [File]-[Save all] menu 
to save Code Generator setting of all projects before existing e2 studio.  



e2 studio 4.2.0 Release Note 

Rev 1.2, Dec 9th, 2015 Page 37

7830 CodeGenerator plugin 

Please declare the local variable in the top of user code area braces. 

E.g.  

void main(void) 

{ 

 R_MAIN_UserInit(); 

 /* Start user code. Do not edit comment generated here */ 

 {   // add  

 uint8_t val1;         // e.g. local variable 

 uint16_t val2 = 8;  // e.g. local variable 

 val1++; 

 val2++; 

 while (1U) 

 { 

 ... 

 } 

  }  // add 

 /* End user code. Do not edit comment generated here */ 

} 

7854 IO view plugin 
Some IORs registered in Selected Registers tab cannot be expanded in IO Register view. 

In this case, please refer to All Registers tab. 

7920 Trace plugin 

When you enable coverage for the RX64M or RX71M, the coverage view does not show 
the result. 

[Workaround] 

1. Open coverage view and set address range before connection. Set all address range as
"enabled". 

2. Connect the debugger and disconnect.

3. Change it from "disabled" to "enabled" and connect the debugger again.

4. Set all the source files as "disabled".

5. Run program and stop it. Then change the source file status from  "disabled" to
"enabled" 
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Renesas Synergy specific open items: 

ID Component Description 

6945 Renesas Synergy 

When using the Synergy configurator. If you rename a thread and generate code, a new 
thread_entry.c file will be created with template content, and old thread_entry.c file will 
remain in project. 

If you have edited thread_entry.c your changes are not moved to new file. 

The old file remains in project but will not be called. 

7111 Renesas Synergy 

In some cases when debugging with Synergy the expressions view can disagree with the 
underlying value of the variable in the memory view. 

To avoid this you can use the real-time memory feature or remove and add the variable 
back into the expressions window. 

7551 Renesas Synergy #error is not reported as an error when building with the IAR toolchain. This can be 
resolved by enabling the GCC error parser. 

7591 Renesas Synergy When cleaning IAR Synergy projects it is possible for the clean to fail 

7672 Renesas Synergy 

When building ThreadX source with IAR compiler the warning "Pa050, Non-native end of 
line" is generated on many source files. 

This is a known issue. If this behaviour is not desirable please suppress the warning in the 
IAR build settings. 

7756 Renesas Synergy e2 studio only supports CMSIS packs which meet the 1.2 CMSIS pack specification. 

7853 Renesas Synergy 

When using the Launchpad toolchain the linker script file is not set as a dependent file in 
the build. 

Changing the linker script does not cause a rebuild. 




